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CUBRID Query Browser

This chapter explains how to use the CUBRID Query Browser, a GUI-based query tool. The CUBRID

Query Browser facilitates various tasks allowing users to execute SQL statements against the connected

database.

CUBRID Query Browser consists of a database server running on a host where the Broker is installed,

and a GUI client. The CUBRID Query Browser Client utility is written in Java and can be run in any

environment that supports Java.
This chapter covers the following topics:

» Introduction to the CUBRID Query Browser
+ Install and Running CUBRID Query Browser

»  Client Features of the CUBRID Query Browser
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CUBRID Query Browser Introduction

The CUBRID Query Browser is a tool what users can use to execute SQLs and manage the objects of

CUBRID databases conveniently.
It can run as a RCP application or run as a plug-in in eclipse IDE.

It replaced the Query Editor of CUBRID Manager before CUBRID Manager 8.3.1 and is integrated into
CUBRID Manager as a plug-in after CUBRID Manager 8.3.2

CUBRID Query Browser Architecture

The figure below shows the architecture of the CUBRID Query Browser. It is developed as an eclipse

RCP application and eclipse plug-in. And as the figure shows, it visits the CUBRID database server
through JDBC driver and CUBRID broker server.

RCP Application Interface Eclipse Plug-in Interface okt
“ Language
Help Plug-in Package
Common GUI Interface
| « Log
Business Logic Interface Faciaoe
JOBC
cub_broker cub_cas . > cub_server
4/72
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Getting started

How to get the CUBRID Query Browser

Requirements

» JDK 1.6 or higher version is required.

» When CUBRID Query Browser is running as a plug-in in eclipse IDE, 3.5 or higher version of eclipse IDE is
recommended.

»  If the operation system is a 32-bit system, the 32-bit JDK is required and the CUBRID Query Browser must
be 32-bit version. And the 64-bit system needs 64-bit JDK and 64-bit CUBRID Query Browser installation

file.

Download CUBRID Query Browser RCP Application

Please visit the web site https://sourceforge.net/projects/cubridtools/ for more information of CUBRID

Query Browser or other CUBRID tools.

Install CUBRID Query Browser plug-in into Eclipse IDE

The steps of how to install it in eclipse IDE are listed:

»  Step 1: Open [Help]>[Install New Software]

i) Welcome

(7) Help Contents

&7 Search
Cryriarnic Help
key Assist.., Ctr+Shift+L
Tips and Tricks...

£/ Report Bug or Enhancement..
Cheat Sheets...

Check for Updates

Install Mew Software...

Ahout Eclipse

»  Step 2: After 'Install New Software' dialog opened, use [Add...] to add the URL

http://sourceforge.net/projects/cubridtools/files/site/cubridquery/ to ‘Available Software Sites'.
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£ Install

Available Software

Select a site or enter the location of a site,

Work with: |https:Hsourcefarge.net,’prujects,’cubridtouls,‘ﬁles,’site,‘cubridquerw v” Add... ]

Fird rnore software by working with the "avalable Software Sites' preferences.

|tvpe filter temt |

Marme WErsion
(1@ There is no site selected.

& Add Site

Mame: |CUEIRID Query Browser H Local... ]

Location: ||et,fprujects,fcubridtDDIs,,fﬁles,fsite,,fcubridquer\,r,r | [ Archive, .. l

@ [ Ok ” Cancel ]

4 4
Details

[ show only the latest versions of avalable software [CHide iterns that are aready instaled

[ Group items by categary wihat is already installed?

] Contact all update sites during install to find required software

@ < Back Mext = Firiish

»  Step 3: Check the last version of the CUBRID Query Browser and use the wizard to finish the

installation.
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& Install [=1[E]]
Available Software
Check the items that you wish o install,

wiorl with: |httr:uz:H5|:|ur|:e1‘|:|r|;|e.r‘uatfr:urn:ujeu:tsfu:uhriu:ltn:un:ulsfﬁlesf5ite,ﬁ:uhridquery,r v|[ Add... ]

Find rmore software by working with the 'Available Software Sites' preferences.

MHarme Wersion
3. CUBRID Query Brovweser Feature 1.0.0.201101181707F

Details

CLBRID Query Broweser
[]show anly the latest versions of available software [ Hide items that are aready installed
[ Group iterns by categary What is alteady installed?

[¥] Contact all update sites during install to find required software

@

After installation, restarting the eclipse is strongly recommended.

How to run CUBRID Query Browser

Requirements

»  JDK 1.6 or higher is required.

»  When CUBRID Query Browser is running as a plug-in in eclipse IDE, 3.5 or higher version of
eclipse IDE is recommended.

»  Ifthe operation system is a 32-bit system, the 32-hit JDK is required and the CUBRID Query Browser

must be 32-bit version. And the 64-bit system needs 64-bit JDK and 64-bit CUBRID Query Browser.
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Run as a RCP application

»  In LINUX: Extract all files of the downloaded file into a dictionary and execute ‘cubridquery'.
»  In MAC: Extract all files of the downloaded file into a dictionary and execute ‘cubridquery'.

»  In WINDOWS: Extract all files of the downloaded file into a dictionary and execute ‘cubridquery.exe’.

Run in CUBRID Manager

It is integrated into CUBRID Manager as a plug-in after CUBRID Manager 8.3.2. CUBRID Manager

8.4.0 include the CUBRID Query Browser all functions before 1.1

Run in eclipse IDE

After the installation is finished and the eclipse is restarted, a new item named 'CUBRID Query Browser'

will be in the [Open Perspective] dialog as follows.

& Dpen Perspective

CUBRID Quiery Browrser
C‘JS Repository Explaring
ﬁDebug

#«FiﬂdBugz

ﬁ’]ava

5 3ava Browsing

‘Eg’:laua Type Hierarchy

L Planning

== Plug-in Developrment (default)
F PrD

L_[‘:,F{esuurce

fmm SN B IREEEHF

&P Team Synchronizing

3 WML

] l [ Cancel

Select it and click [OK], the view of eclipse will be as follows and now you can start to use CUBRID

Query Browser.
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& CUBRID Query Browser

File Edit Mavigate Search Project Run CUBRID  Window  Help

] | QR =B : L
11 CUBRID Connections Explorer 53 = =B
search: | v |

572 NEN



User Manual

Concepts

Main Toolbar

These buttons of tool bar are some shortcuts of the main menu items of CUBRID Query Browser.

™ | e i Ty | A | |
- e : | 2 \ ?/9\ Rfa | b3 |
(8" Tdw : [ L& L~ L ® L&) L

Mew Connection Mew Query Editor  © Create Table Create View Create Serlal Create Trigger Create Function Create Procedure Refrash

New : I Create a new CUBRID Database
Connection . Connection when it is clicked.
New Query _Li'.:;li Create a new query editor window
Editor = of current selected connection
when it is clicked.
Create Table |_:| Open Create Table Dialog when it
- is clicked.
Create View |_:| Open Create View Dialog when it
B is clicked.
Create Serial j I Open Create Serial Dialog when it
- is clicked.
Create gﬁ I Open Create Trigger Dialog when
Trigger - it is clicked.
Create "i'-'-"arl Open Create Function Dialog
Function B when it is clicked.
Create ﬂf,f I Open Create Procedure Dialog
Procedure - when it is clicked.
Refresh @ Refresh current node which is

selected when it is clicked.
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Connection Explorer

Connection Explorer

The left view which title is "Connections" is a database connection explorer. Each Database Connection
Node in it is a container that stores a set of parameters which can be used to connect a CUBRID database

through CUBRID JDBC driver.

And when the connection is opened, it can list the database’s objects such as tables, columns and indexes
of tables, views, triggers, serials and procedures with a tree view structure. Users can do something with
nodes that are listed such as creating/dropping tables; creating/dropping views and etc by execute its

context menus popped by right clicked.

Connection Explorer have it’s menubar and toolbar.

{1l Connections =
Search: =3 Top Lewel Elementzs F#
-1 10,34, 63, 132 Group Settings. ..
= LE| Tables 1 10.34.83. 132
+-|_J Sy=stem tables 7 1034, 63, 134
il j‘zcﬂmng 3 10.34.83.133
Ty
,; s, integer SeFilter.
b, JI.nteger —|Collap=e A1l
c, 1nteger -
= Indexes
¥ pk_abe_a(a)
4= fool
4= food
+-=] infao_thl
+ = test
+- = zipoode
=1 ¥iews

-] System wiews
| test_wiew
| owiawl
= j_,élTriggers
e abe
= j Serials
=
=% Stored procedure
+-_J Function
+-_J Frocedure
i 10.34.83. 134
i 10.34.83. 133

T NEN



User Manual

Object Find and Filter

Find Object

The text editor named “Search” in connection explorer toolbar is used to find locate the node of the tree

by node’s name. It support the pattern, * stand for any string, ? stand for any character.

Filter Object

You can filter the elements in connection explorer by the below ways.

! Connections []= 8 /@ CUBRID Infarma
Search: = Top Level Elements  #
=13 Default Group Group Settings...

i) localhost 1 Default Group

= 'JJ E?rru:ute aroup 2 Remote group
iz 10.34.63.132 v
— - —Filter... ‘
i_—-.l 1 34, ._I o

—| Collapse &l

The menus will be popped when the button which’s shape is triangle is left clicked.

(1) Use checkable action to show all top level elements in navigator menu. When checked, hide this

element; otherwise, show this element.
(2) By Filter dialog

If the menu named “Filter...” is clicked, a filter setting up dialog of the tree view will be opened as

follows:

e NEN



User Manual

43 Element Filters

Element Filters

Setting the filters to exclude from the views

[Cpamne filter patternsimatching names will be hidden):

The patterns are separated by comma,where * = any string,? = any character,

Select the elements to exclude from the views:

175 10.24.63.132
[]ig localhost
[1ig 59.102.03.82

@::l Q. H Cancel ]

The nodes which are checked in the tree view of dialog will not displayed in the Database connection
node tree view. Or if the “name filter patterns” is setting with expression, the nodes which have the
names that match the patterns will be hided. The patterns can be split by «,”. For example “test*” pattern
will make all nodes which name is started with “test” hided such as “test-db”, test1234”..., and the
“demo?” pattern will hide the nodes which name is started with “demo” and the length of name is 5,

such as “demol”, “demo2”...

(3) All nodes in the connection explorer have two context menus [Hide] and [Show Hiden].
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1 Connections

Search:

b

= Default Group
i localhast
= Remote group
=g 10.34.63,132

=15 Tables

[ Systemn tables
=-E il —

o[y Lo Mew Query Editor

~ Select Counti*)
Copy SOL to Editor

Ea Copy SOL to Cliphoard

= fod Copy SOL to File. .,

—:] infl 3 Insert Simple Data. ..
=20 Eyecute Prepared SOL

1 wigws

0 10,3463,

&l Trigge g2 Import Data...

= Serials| .4 Export Data..,
L% Storec
Shiowe Scherna Info...

[ Edit Table. ..
More

= = O || (@ cuBRIC

d

1 SELE
2
3 SELE
4
S SELE
&
7

B

Z Refresh

[Hide] will hide current selected node and all children of it.

[Show Hidden] will make all children of the selected node visible.

Connection Group

If there are lots of database connections in the connection explorer, users can use group manager to

classify those connections.

F=

The explorer supports two kinds of view style to display connections-[Item] or [Group].

i1 Connections

Search:

= ) Default Group

i locahhost

=i 10.34.63,132 .

=15 Tables

[ System tables
P .

[7] = B @ cUBRID Information £33 ¢

Top Level Elerments

GroLp Settings. ..

1 Default Group
oEilter...

= Collapse Al

14/72
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If item style is selected, all connections will be listed in the explorer without grouped. As follows:

11 Connections ¥ =0

Search: w

i 10.24.63.132
i 10.34.63.222
i0 lncahost

If group style is selected, connections will be move to specific groups. As follows:

i1l Connections ¥~ =0

Search: w

[=- ¥ Default Group |
i localhost

[ =Y Remote group |

o 10.34.63.122

g} 10.34.62.222

And users can use [Group settings] to manage the groups. The menu is as follows:

i1 Connections

Cearch: -

[7]= B (&) CUBRID Informat

Top Level Elerments  * |

Group Settings. ..

= Default Group

L localhost 1 Default Group
=13 Remote group

oo 2 Remote group
im 10.34.63.132 ,

uFilter...

= Collapse Al

Database Connection

Database connections are listed in the connection explorer and they store the information of how to

connect a specific CUBRID database server.
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=1 v
-

Search: w

) Default Group
=Y Remote group
o 10.34.63.132

i3 10.34.62.222

Users can add, edit and delete the database connections by using menus.

Application Title and Status

In the title of application, current database connection information will be displayed as follows:

#% CUBRID Query Browser - 10.34.623.123 / dbamdemodb:30000: charset=UTF-8

And in the status bar it will be shown as follows:

dba@dernodb: 20000:charset=UTF-2

And the information will be changed with the changing of the selection of connection node or query

editor.

Query Editor

Open Query Editor

There are lots of ways to open a query editor.

»  Ifthere is no database connection selected in the tree view, the menu [Tools]>[New Query Editor] is
as same as the button [New Query Editor] in the tool-bar. Both of them will open a new Query Editor

and users should input the database connection information into the dialog opened.
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il Action  Help
22 Mew Query Editor

7 New Custom Query Editar

OI0 Mavigatar, ..

vl Create Seril...

§1 Create Trigger...

5 Export Data...
E=g Import Data.., _

Execute Prepared SOL 4 or Mesy Query Editor

The dialog will be opened as follows:

45 New Query

New Query

MNesw the self-defined query connection for query editor
according to registered connections,

Registered Connection Information

Conmection name: E;Eelf Defined Connection

Database Inforrmation

Database IF: |

Database name: |

Llser name: |

Password: |

Eroker Inforrmation

Eroker IF: |

Eroker port: |

Character set: |UTF-B

v

JDBC version: | CUBRID-DEC-8.3.1.0061 v||Browse... |

@

17/72
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»  The context menu [Open Query Editor] of database connection/table/column/view will open a new

query editor.

71l Connections ¥ = B |4 CUBRID Infc
Search: | | Mo databas
= Default Group 1
=g - ;
[15RE & Open Connection. .,
11 yie L1 Cose Connection
b .
ok f Mewy Connection, ..
il o [1e Delete Connection
=5 Rfmuteg 01D Mavigator...
i 10.34

22 MNew Query Editor

£2) Database Version...

7 Praperties ALT+EMTER
= Hide
= Refresh FS

»  The context menu of query editor tab also has an item to open a new query editor with current query

editor’s database connection:

Euj Query Editr-* = ruimy Colive,
Mo databs Ea‘]
1 SELECT | 2% v
2 Minirnize
3 SELECT | Maximize !
4
S SELECT | QDSE Ij
? Close Others
Close Al
2 Mew Query Editor

Query Editor Overview

Users can do a lot of works such as edit/execute SQLs, check results of the executions, view logs, check

execution plan and etc by using Query Editor.
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Query Editor 22 =5
dbamtestdb M eHE O3t & ¢ 2R nres=s 0 % @ 8
1 Connect Database Information Toolbar
Query Editor Window

‘Query Explairﬂ =0

Query Result Windows

Tab

Query Editor Toolbar

Users can change the database connection of current Query Editor by changing this option.

K Query Editor 52

dha@test1 |1 = 5 Gl
Mo database selected

® 10,3463, 132

10.24.63.123

Self Defined Connection

The yellow highlighted sections in the figures above indicate that current database connection is named

“10.34.63.132” and the login user is named DBA and the login database is “test1”.
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If a different database connection is selected when the query editor has a transaction not finished, a
dialog will be popped to prompt how to deal with the not finished transaction: commit or rollback or

cancel current changing:

’@ Confirm

There are some related transactions of the databaze “10. 34,83, 132" not
\__4-/ committed in query editor , do wou want to commit?

Yes | [ Ho

The edit function of the Query Editor is synchronized with [Edit] on the main menu. The following table
shows the options available on the Query Editor's toolbar: Major options are provided with a shortcut

key.

= R YO AR/ K =E=ES G

¥
ey
Ll

Open = Opens a text-based SQL and
displays it in the query edit panel.

Save E] Saves the contents of the query edit
panel.

Save As E Saves the contents of the query edit
panel in a different name.

Run ﬁ F5 Executes all the queries in the query
edit panel. Alternatively, executes
queries selected as a block. This
icon is deactivated when the

execution is unavailable (D).

.

Commit Keeps deactivated in auto-commit

mode (ltti); while in
non-auto-commit mode, allows you
to commit (!?:J) explicitly when a
transaction occurs.

Rollback iz3 Keeps deactivated in auto-commit
mode (lr'l); while in
non-auto-commit mode, allows you

to rollback (!=‘J) explicitly when a
20772 INST=1~)
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auto commit

Display query

plan

Undo

Redo

Find/Replace

Find next

Convert to

comment

Delete
comment
string

Insert tab

Delete tab

@

%

F6

Ctri+Z

Ctri+Y

Ctri+F

F3

Ctrl+/

Ctrl+/

Tab

Shift+Tab

transaction occurs.

Automatically commits queries

executed in the query edit panel.

You can toggle the icon. When auto

commit is on, the icon is displayed

asi 3_’, and when it is off, the icon
2]

is displayed as &

Note that the setting is only applied

to the corresponding Query Editor;

that is the default value of the

option is not changed.

Displays the execution plan of the

selected query. For more

information, see Query Execution

Plan.

Cancels the most recent edit action.
Re-executes the most recent edit
action that is canceled by Undo.
Provides search and replace
function that can be used in the
query edit panel.

Provides further search for items
that are already searched once.
Adds the comments to the selection
area or to the line where the cursor
is located in the query edit panel.
Comment strings are inserted with
a double dash (--).

Deletes the comments from the
selection area or from the line
where the cursor is located in the
query edit panel.

Indents the selection area in the
query edit panel.

Un-indents the selection area in the

query edit panel.

T NEN


http://127.0.0.1:3226/help/topic/com.cubrid.cubridquery.help/html/querybrowser/manager_queryeditor_queryplan.htm
http://127.0.0.1:3226/help/topic/com.cubrid.cubridquery.help/html/querybrowser/manager_queryeditor_queryplan.htm

User Manual

Format SQL

Get OID info

Set defined
SQL

parameter

SQL Quick
Help

Show or Hide
Query result

panel

Edit SQL

I

Shortcut Menu

Ctrl+Shift+F

Formats the selected SQL strings in
the query edit panel.

A toggle button available on the
toolbar in the query edit panel for
[Get OID info], which can be found
in the Query Editor options. That is,
by selecting this button on the
toolbar when [Get OID info], which
can be found in the Query Editor
options, is OFF, you can directly
modify/delete data in the query
results panel for subsequent
queries. In this button is selected
on the toolbar, however, this only
applies to the corresponding Query
Editor. The values of the Query
Editor options for the corresponding
database won't be changed.

To specify a parameter whenever
the statement is executed, write
Prepared Statement, select the
written statement, and click the
icon.

Find the help about the words which
you selected in the SQL edit panel.

Show or Hide query result panel.

If you right-click on the query edit panel, you can select Copy, Cut, Paste, Find/Replace, SQL Format

and Show Schema Info. The editing function is synchronized with [Edit] of the menu.

2 NEN



User Manual

[ *Query Editar 52 =8
chamtestdb YmHE | O &G =@ ¢4 | AR 1= 5 %O
JECELECT "f2" FROM "testl";
2 Copy Ctr+C
Cut Ctrl+x
Eind/Replace... Ctrl+F
£ S0L Format

Shortcut menu
Shiow Schema Info..,

() 5L Quick Help...

Show Schema Info

If you select a table name and then execute [Show Schema Info], you can create a query while seeing the
Query Editor view and the Schema Info view on the same window. Note that you can view the schema
information only when executing Query Editor in the Explorer (toolbar not supported).

[ *Query Editar 23 = O|/|5 schema Info 52 =08

dhaitestdb vYzHE O d®& an ¥ AR BN EES| G O H testl

1 select * from "test1"; Schema type User schema

Owner DBA
Super table
Type Table

Columns:

PK | Columnn Name  Data Type
f2 MCHAR(L)

Automatic Completion

If you enter a CUBRID database keyword, CUBRID automatically finds and completes the statement,

increasing usability and user accessibility.

2 SELECT sys_

SYS_DATE
SYS_DATETIME
SYS_TIME
SYS_TIMESTAMP
SYS_USER

Executing Multiple SQLs

Enter a semicolon at the end of the query statement to specify the end of one query and the start of the
next. If there are multiple queries, they are executed sequentially. Each query creates a corresponding tab
in the query results panel. If you execute multiple queries without separating them with semi-colons,

only the first query is executed, with the rest ignored.
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[ *Query Editor &3

dha@testdb v =Y E

1 SELECT "f2" FROM "testl'
2 SELECT "f1" FROM "test2'
3 SELECT "f1" FROM “testd’

Executing SQL Quickly

Press Ctrl+Enter will execute the sql where current cursor is.

Drag and Drop

If you drag and drop a table or tables to retrieve from the connection navigation tree into the query edit
panel of the Query Editor, a SELECT query statement is created automatically. Multi-tables drag and

drop is supported.

And the columns of tables also support drag and drop to the query editor.

71 Connections © 7 O RS *Query Editar

Search: w dha@testdh ol

=14y 10.34.63.132 1]
=I-LE] Tables

+-[ 1 System Ea_tfi_________—————
Efrestl

= test2

= test3

= tests

+

DOrag & Drop

+- [+

Cancel SQL Executions

It is a function to stop current running SQL execution. This can be divided into two functions.

» When executing multiple queries : If you click the Stop button when multiple queries are
being executed with the auto commit button enabled, queries processed before the stop operation are
reflected normally, and the currently canceled query and following ones are not reflected. If the auto

commit button is not enabled, no executed queries are reflected.

> When executing a long time transaction: If you click the Stop button when executing a
long time transaction, a query stop command is delivered to CUBRID Manager > JDBC > Broker >
Server, and the query finally stops in the database server the query is actually canceled. For Windows,

this function is supported in CUBRID 2008 R2.2 or later.
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] x

dba@testdh bt
g F A4 131 =
1 SELECT "code”,"nar
2
3

Result | Query Explain

2", 'gender”,"nation_code”,"event” FROM "athlzte”;

=0
A

)]

SQL Execution Results Panel

Structure

The query results panel displays the results of the executed query. If there are multiple queries executed,

the results of each query are displayed in separate tabs. Users can check the query results by selecting the

corresponding tab.

The query results panel is divided into areas where you can navigate the results, view information of the

executed query, and check execution time and the number of results returned by the query.

ResLlt . Query Explain

WO code  mame
10999 Fernandez Jesus
10995 Fernandez Jaime
10997 Fernandez Isabel
10996 Fernandez Gigi
10995  Fernandez Ana Ihis
10994 Fernandez Abelardo
10993 Feri Attila
10992 Felisiak Robert
10991 Feklistova Maria

10 10990 Fei Alessandro

11 10939 Fesney Carol

12 10988 Fedtchouk Andri

13 10987 Fedotova IMna

14 10986 Fedkin Yur
select * from "athlste”
where rownum between 1 and S000;
select * from "athlete”
wehere rownum == 5001;

Lt w N N ) I N TR O O ey

Query execution information

resultl o

gender

EEESESE=ZEZSSSZ=E

=0
Results search E=r
nation_code  event 5
ESP Handball
ALS Rowing
ESP Juda
USA Tennis
(ul=} Yolleybal
ESP Footbal
HUIN wigightlifting
5ER. Fencing
RUS Shooting
A Wolleybal
LISA Rowing
LIKR. Boxing
RUS Rawing
ELIN Shooting bt
1'th query

[ 0.703 0,702 second , count of total rows : 5000 ]
[ 0.5 0,500 second , count of total rows 1677 ]

Execution time, Number of hits

If a SQL statement such as SELECT is executed or if there is an error when the SQL statement

executed, query execution information and error message or execution time information are displayed in

the Logs tab.
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Result . Query Explain

selact * from "athlete2"”

whizre rownum between 1 and S000;

1'th query
ExeCUte error-493

Error description:

=g

Syntax: Unknown class "athlete2", select * from athlete2 where

oL between 1 and 5000

> Results search: You can navigate the entire search results while moving by the value set in [Page unit of

result instances] of [Query options].

»  Query execution information: Shows from which query the current result comes.

»  Execution time and Number of hits: Provides information about the execution time on the server to get

the current query results and total search count.

Context Menus

As shown in the figure below, the query results panel's shortcut menu contains some options such as

Copy, Delete, OID navigator, View detail, Export all and Export selected.

Result

code
10999
10992
10997
10995
10995
10994
10993
10992
10991
10 10920
11 10939
12 1M9=s

[T m]xJUrUIA.UJii+4 =
(]

Query Explain

rame

Fernandez Jesus

Fernandez
Fernandez
Fernandez
Fernandez
Feri Attila

Felisiak Rob
Feklistowa I
Fei slessarn

Copy

Wiewy detail
Export all

Expott selected

gender
ESP

M
L aUs
I

ESP
LSa,
| CUE
ESP
| HUM
GER
| RUS
IT4,

Feeney Caral

Fedtrihon ik Andri

) LS4
M LIKR

ration_code

= 5
ool | 31

event ~
Handball

Rowirng
Judo

Tennis
yaolleybal
Foothall
Wigightlifting
Fencing
Shooting
Wolleyball
Rowing
RBrxinn

Copy: Copies an entire row. To copy a specific column of the row only, select [View detail].

Edit field’'s value: The information can be modified directly from the query results panel. Change

data to a modifiable state by double-clicking it, and then modify it. This option is available when [Get

OID info] is set in the given host's Properties () > [Query] dialog box, or [OID info ( iNlis

specified.
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Result

MO

Lo N o RN S PR

Query Explain

QI

@as0(1 (0
@a20|2 (0
@ae0|3(0
ma20 (4 (0
@as0|S5 (0
@as0|6(0
@a20|7 |0
@as0|s (0

code

10999
10992
10997
10996
10995
10994
10993
10992

rarm
=ernand SLIS
Fernandez Jaime
Fernandez Isabel
Fernandez Gigi
Fernandez Ana Ihis
Fernandez Abelardo
Feri Attila

Felisiak Robert

gender

ZEZEZEEEZE

= B8
db oo
nation_code  event "
ESP Handball
AlS Rowing
ESP Judao
LIS, Tennis
CLE Walleyball
ESP Foothal
HLIM Wigightlifting
GEFR. Fencing

Delete: You can delete data directly in the query results panel. Right-click the row to delete and then

select [Delete]. This option is available only when [Get OID info] is set as the modify function does.

OID navigator: This option can be activated by right-clicking an OID data in the [OID] column as

follows. It provides a function that allows you to navigate the selected OID directly.

Result . Cuery Explain
MO a
1 @e0oj1jo 1
2 @e00|2|0 795189
4 @e0C  “OPY
5 @s0C  Delete |
5 @E0C :
- @e0r | OI0 navigator |
=] @eoC  iew detail
9 @00 Ewport &l |
10 @600 Eynort selected
14 AT |

And the OID navigator as follows will be poped:
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43 01D Navigator

0ID Navigator
Mavigator data by OID.

OID value: |@E00|3|0

= @a00|3|0
table name: abc
a, Fosz20g
b 3
C. o

View detail: If there are too long data to be displayed in a single row, or if its size is too big, it is
very difficult to see column values on the query results panel. In this case, you can see column values in
detail by right-clicking the row and then selecting [View detail]. You can also modify data directly in the
[Detail] dialog box if [Get OID info] option is set. For BLOB or CLOB type data, you can import and
export it with a separate file. When column data type is varchar and similar varchar such as char, nchar
and etc, file type should be (.txt), if the column data type is another type except BLOB/CLOB, the
import/export button will be disabled. And if column data type is BLOB/CLOB, the file type should be

the right file type which depends upon the real data type.
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#%Row Detail Information |_:|

Row Detail Information

Show the selected row detial information.

Colunn mame.  1niroduction V|

Colunn fype:  WARCHAR (1500) |

Set walue in the below Ltext area

Column walue:

Ln 2004 the Olwmpte Games retuwrned Lo Greecs, the home of both the ancient
Mympics and the first modern Dlgympics, For the first fime ever a wecord Z01
Hational Olympic Committess (M0Cz) participated in the Olympic Games. The
overall 1ally for evenis on the programme was 301 (one more then in Sydney
20000, Popularify in Lhe Games zeared Lo aew highz az 3.9 billien people had
accass to the felewiszion coverage comparad o 3.6 billion £or Sydney 2000,
Foman' "= wrestling was ineluded nothe program for the first time. Swimmsr

Wi echael Fhelps won B gold medals and el a zingle=Games record with § tobtal
sedals Leoniien Ziljaard-wan Moorsel became the first female cwelizt to ezmrn
4 caresr zold nedsls and & total medals, while canosist Birgsit Fizcher became
the Lirst athlete in any zport Lo win twe medels in each of 5 Olwmpies.
Eurmer Hicham ZI Guerrour won both the 1 500m and the 5, 0008, while on the
=omzn = side Helly Holmes triunphed in both the 300m and the 1,500m. In tesm
olarw, Argentina won the mer = football towrnament without ziving up a zosal,
and the Wi S s'.-:\-'Fi_':\ﬁi]-l. Laam won '!'-y f_\-lﬂ.:r'-_'\-:"ir:g thear opponents Si-1

[]5et ML

Import or export dats by fi1le

File charset: |UTF-G v

[l"-!-'"i-l't- ¥ ] [E::pc-:'t. .. ]

.

@ [ Updatle ] [ Cancel ]

Export all: Exports all data in the query results panel to an Excel or a CSV file.

Export selected: Exports only the data in the row selected in the query results panel to an Excel or

a CSV file. The char-set for a file where exported data is saved can be specified.

Export data: Exporting/importing data for BLOB, CLOB, BIT VARYING (>100) cannot be
executed, but importing detailed information in the result panel of the Query Editor is possible. Note that
only type tags such as (BLOB), (CLOB), and (BIT) are displayed in the result panel, instead of

displaying real data.

Import data: If field type is STRING, CHAR, VARCHAR, NCHAR, NCHAR VARYING,
BIT VARYING, BIT, BLOB, or CLOB. The [Import] button will be enabled and users can change

the field value by specify a file.
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Result

L1 N T O

When users place the mouse pointer over a column name of the query results panel, a hint about current

column’s type and size will be popped.

Query Explain = B
CL=F i +

() (] code | name gender | nation_code | event G
@E80|1|0 10999 Fernandez Jesus ESP Handball
@E20[2|0 10928 Fernandez Jaime  [VARCHAR{40) AUS Rowing
@EE0|2|0 10997 Fernandez Isabel iy ESP Judao
@E80|4|0 10996 Fernandez Gigi Wy ISe, Tennis
mEanIsIin 1M005  Farhandar fna Thic i I l[=! Winllawhall

Query Execution Plan

If [Display query plan] is selected in the Query Editor's options, [Display query plan ;zz] becomes

activated in the Query Editor Toolbar.

You can check how the selected query will be executed, even without executing it, by clicking [Display
query plan ;=] from the toolbar or by clicking < Ctrl+L>. You can also check query execution plans that

have already been executed.

Since query plans are displayed all the time at the bottom of the Query Editor window, you can check

the existing query plans by opening query plan history files without connecting to the database.

The query plan function retrieves the SQL execution plans it is used not for a one-time purpose but for a
collection purpose to continuously manage and retrieve them. Every time you retrieve a query plan, the
query plan history is accumulated. You can save this accumulated data to an .xml file. When you open
the saved .xml file, you can check the original query plan and executed SQL statements. If it is a
one-time retrieval, select [Disable to collecting histories| ] to view the current query plan without

recording history.

The [Query Explain] tab consists of a toolbar, query plan display panel, original statement display panel

and query plan history panel.

Query Explain tab

If you select a query and then click [Display query plan szz], the query plan is displayed in the [Query

Explain] tab. The [Query Explain] tab shows the query plan summarized in the tree structure.

The [Query Explain] tab is located to the right of the [Result] tab. You can switch to the [Query Explain]

tab while viewing the query result.
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Result FQuery Explain =8
& HE | &,
Type Table Index Terms CPU (i) 10 iffv) Total (rjp) # Date Cost
= idxt-join (inner join) 0.0/10.0  3.0/94.0 1 2011-01-21 134758 1810
| sscan record a 0.0/5.0 0.0/47.0 2000/47 2 2011-01-21 13:47:58 1.0
= o5 iscan athlete b pk_athiete_code 0.0/00  3.0/40  E677/164 3 | J011-01-21 134758 | 52.0
term:index a.athlete_code=b.code 4 2011-01-21 13:50:04 1070
Join graph segments {f indicates final): ~
seg[0]: [O]

seg[1]: host_year[0] (F)

seg[2]: event_code[0] (f)

seq[3]: athlete_code[0] (f)

seq[4]: medalo] (f)

seq[S]: score[0] ()

seg[6]: unit[0] (F)

seg[7]: [1]

=eg[8]: code[1] if)

seq[9]: name[1] (f)

seq[10]: gender[1] (f)

seq[11]: nation_code[1] (f)
ceg[12]: event[1] ()

Join graph nodes:

node[0]: record ai2000/47)
node[1]: athlete biEE77{164)

Join graph equivalence classes:
eqclass[0]: athlete_code[0] code[1]
Join graph edges:

term[0]: a.athlete_code=b.code {sel 0.000149762) (join term) (mergeabla) (inner-join) {indexable athlete_code[0] code[1]) {loc O)

Query plan:

Query Explain Toolbar
The Query Explain toolbar has the following functions:

New — : Initializes all query plan histories retrieved so far and begins collecting them again. This

function is used to initialize the existing job.

Open a query explain file [=: Imports a previously saved query plan history file. If you open

the .xml file, you can view the original query plan.

Save a query explain file|=| Save a query explain file as [ : Saves the collected

query plan to an external file. The file extension is xml.

Disable to collecting histories| : Histories are added to the query plan history panel
whenever you retrieve the execution plan by using [Display query plan] in the Query Editor. To retrieve
a query plan temporarily without recording history, click [Disable to collecting histories|"4]. The name

of the tab below the query plan display panel is displayed as "plan."”

Query plan type|:: || =|: By toggling the icon, the type can be switched between text |=land tree

=2°]. You can view the unprocessed query plan source created by the database in a text form.
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Result (*Query Explain =0
= HELE w“

Join graph segments (f indicates final): A || # Date Cost

seq[0]: [0] 2011-01-21 1%47:58 181.0

)
seg[1]: host_year[0] (F)
seg[2]: event_code[0] (f)
seg[3]: athlete_code[0] (f)
seg[4]: medal[0] (f)
seg[S]: score[0] (F)
seg[6]: unit[O] ()
seg[7]: [1]
seg[2]: code[1] (f)
seg[9]: name[1] (f)
seg[10]: gender[1] (f)
seg[11]: nation_code[1] (f)
seg[12]: event[1] (f)
Join graph nodes:
node[0]: recard a(2000/47)
node[1]: athlete b(6677f164)
Join graph equivalence classes:
eqdass[0]: athlete_code[0] code[1]
Join graph edges:
term[0]: a.athlete_code=b.code {sel 0.000149768) (join term) {mergeable) {inner-join) (indexable athlete_code[0] code[1]) {loc 0)

2011-01-21 134708 1.0
2011-01-21 134758 520
2011-01-21 1350004 107.0

FNYN N

Query plan:

id-join (inner join)

outer; sscan

dlass: a node[0]

cost; fixed 0(0.0/0.0) var 52(5.0/47.0) card 2000
inner: iscan

dlass: b node[1]

index: pk_athlete_code term[0]

cost; fixed 2(0.0/3.0) var 1(0.0/1.0) card 6677
cost: fived 3(0.0f3.0) var 104(10.0/94.0) card 2000

Query strt:

plang &3

Show or Hide a query history panel s || |: Shows or hides the collection history panel on

the right side.

Query plan history file: If a query plan history is saved as a file, or an existing file is opened, the

name of the currently used query plan history file is displayed.

= B L E # [ History file: his.ernl |

Query Plan Display

In the query plan display panel, the query plan executed in each step is displayed in the tree structure.

Each item in the vertical axis is called a node. Each node contains different data. You can view the tree

moving from the top to the bottom.

The horizontal axis is called an item and contains Type, Table, Index, Terms, CPU 1/O cost, Disk 1/0

cost, and Total (ROW/PAGE).

Type Tabiber Trodbens Tetls CRU () 10 f)  Toral (rip)
= tempidistinct) 5700 .0
= mi-joir irresr join) 000,49 L0
ke oin by, bucest_ymar=0.host_yaar
Ta ETAn alyrngic o pk_olympic_hoest_ysar 0.00.0 Laafi.0 2574
berm ik o,host_paar range (1950 9. ..
S5CAn Fistory b 0.0/0.4 0u0s.0 14715
term:selact i baoest_yaarmn.host_year
£ ¥

Type: Indicates the scan type or join method (such as sscan, iscan and idx-join).
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Table: The table (class), view (virtual class) and alias, which are referred to when the node is executed,

are displayed altogether.
Index: The name of the index used is displayed if the type is iscan.

Terms: Join and filter conditions are displayed. The contents are hidden for readability. If you click [+]
button, sub-nodes will be extended to show the details. In addition, different colors are used for different

search conditions.

Cost: Displays CPU and Disk 1/O cost of the query plan. Fixed and variable costs are displayed

separately.
Total (r/p): Displays the total number of rows and the number of pages to be used to fetch data.

The original statements of the query plan selected in the query plan panel are displayed below the query

plan display panel.

Join graph segments {F indicates final): -~
seql0]: [0]

sea[1]: host_year[0] (F)
seq[2]: [1]

segl3]: host_nation[1] (F)
seq[4]: host_vear[1]
Join graph nodes:
relal 1] higkree k147 15)

plan1 planz :3

Query Plan History: Histories are displayed accumulatively in the query plan history panel every time a
query plan is executed. # is the accumulation order and corresponds to the tab number below the query
plan display panel. Date indicates the date when a query plan is executed, and Cost is the sum of CPU
and Disk 1/0 costs. If you double-click an item in the query plan history panel, you can view the query
plan again in the query plan display panel.

# Date Cost
1 2009-08-26 16:10:20 14.0

2 2009-08-26 18:13:15  14.0
Using Query Plans

By using the query plan function, you can analyze data while viewing the query plan and the schema

info of the corresponding table.

If you right-click a row where a table is located in the query plan display panel and then select [Show

Schema Info], you can open and view the schema information of the table as well.
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| = U B | B 5 History file: his.xml

Type
= [ idx-join

(inreEr join)
il

= soa iscan
termindes:

Tahl=

Inces

Ter

a.atl

You can also view the information in a separate window by dragging the Schema Info panel out of the

CUBRID Manager. This can be useful in an environment using multiple monitors.

[ *Query Editor 2

1 SELECT "code", "nhame", "gender" , "nation_code" , "event” FROM "athlete";
2 SELECT "s_namz", "f_name" FROM "code";

3 SELECT * FROM "record” a,"athlete” b WHERE a.athlete_code=b.code;

4

dba@demodb Y EEHE O B8 G S RN =

+
il

e
[+

| = [H B | BB

History file; his.xml

Type
(= [ idx-join {inner join)

Table

athlete b

Inclex Terrms

pk_athlete_code
a.athlete_code=b.code

= saz iscan
termmindex

<

.

Join graph segments (f indicates final):
eg[0]: [0]

17: host_year[0] (f)

21 event_code[0] (f)

3] athlete_code[0] (f)

47]: medal[0] (f)

5]: score[0] (f)

6] unit[0] (f)

7] [1]

2]: code[1] (f)

9]: name[1] (f)

10]: gender[1] {f)

eg[11]: nation_code[1] {f)
eg[12]: event[1] (f)

Join graph nodes:

ode[0]: record a(2000/47)
ode[1]: athlete hiEET7/164)
Toin graph equivalence classes:

g
29
29
20
20
20
=)
g
g
g

|>

# Date

2011-01-21 13:47.58
2011-01-21 13:47.58
2011-01-21 13:47.58
2011-01-21 13:50:04

ESFRNNI

34/72

Cost
181.0
52.0
107.0

5 schema Info &2

athlete

Schema type User schema

Owner
Super table
Type

Calumnns:

PUELIC

Table

code
name

avent

< |

Pk Column Mame

gender
hation_code

Data Type
INTEGER

WARCHAR (40
CHAR(1)
CHAR(3)
WARCHAR (30

>

Foreign keys:

FK Mame

< |

Calurnn Marne

2

Incexes;

Index Narne

Index Type Q1

ISI=Isd
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Tasks

Connection Group

Change display style

If the [Group] menu is checked as follows:

i1 Connections

Top Level Elernents

Search: |

= U3 Default Group Group Settings...

.:ﬂ lacalhost 1 Default Group
=g 10.34,63.132 L Fiter
=15 Tahles e

1 System tables = Collapse Al
e -

The connection explorer will be as follows:

11 Conrections ¥ =0

Search: | W |

|=- Y Default Group |
i locahost

(= Remote group |
‘;ﬁ 10.34.63. 132

If the [Item] menu is checked as follows:

11 Conrections =g

Top Level Elernents

Search: |

0 10.24.63. 222
=R 10,2462,

Group Settings. ..

110.34.63.222
2 10.34.63,132

uFilter...

= Collapse Al

4

[7] = 5 /(@ cuBrID Information [ ¢

Item

W SroLp

f2", "f3" F
f2", "f3" F

GaroLp

The connection explorer will be as follows:
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11 Conmections

Search: |

1 10.24.63.132
i 10.24.63.222
i localhost

Add Group

i1 Connections

[7]= B (&) CUBRID Informa

Search: |

Top Level Elerments  *» |

=y Default Group
i0 locahost
=Y Remote group
13 10.34.63.132

ey 10,34, 2

Group Settings. .. |

1 Default Group
2 Remote group

= Collapse Al

The [Group Settings] menu will open a group management dialog:

@ Group Settings

Select and sort groups.

Diefault GrDuE T
Do
Bottom

| add... | [Edit... | |Delete|

@ [ ok ] [ Zancel

36/72
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The default group cannot be edited and deleted. It stores all connections that are not in other groups.

Click the [Add] button, a adding group dialog will be popped:

& Group Settings

Add a new Group.

Add a new Group.,

Group Mame;

10.24.63.222
10.34.63.132

@

The group name is required and the name cannot be duplicated.

Moving the connections from left to right can make the connections belong to current new group.

Moving connections from right to left will remove the current group’s children connections.

Edit Group

Open the [Dialog Setting] dialog and select a group and click button [Edit]:
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4 Group Settings B](=1]E3

Edit a group.
Edit a group.

Garoup Mame;

Jemote group

10.24.63.132 10.24.563.222

M W
i R

@::l (]34 ] [ Cancel

The name cannot be duplicated.

The default group cannot be edited.

Delete Group

Open the [Dialog Setting] dialog and select a group and click button [Delete].
The children connections of group to be deleted will be the children of default group.

The default group cannot be deleted.

Change display order of groups

Open the [Dialog Setting] dialog and select a group and change its display order by buttons [Top], [Up],

[Down], [Bottom].

Drag and Drop

The connection explorer supports that a connection or connections are dragged from one group and

dropped to another group, after the dropping, connections will be children of the new group.
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i1 Connections ¥ =0

Search: | v

=y Default Group

53,132
= Remote group
"D 103463222

Database Connection

Add Connection

There are lots of ways to add a new connection.

It can be selecting the [File]>[New Connection] menu or [New Connection] tool button or [New

Connection] menu in context menu of group and connection nodes.

The new connection dialog will be popped when the menu selected:

& New Connection

Mew Connection

Mew the guery connection, please set the databaze
connection information,

Connection name: | |

Database Information
Database IP: |

Database name: |

|
|
Llzer name: | |
|

Passwiord: |

[]5ave password

Broker Information
Braker IF: | |

Broker port: | |

Character set: |UTF-B w |

JDEC versior: | CUBRID-JDBC-8.3.1.0061 v | | Browse... |

Q

All input area cannot be empty except password.
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Connection name cannot be duplicated.

If [Save password] is checked, next time when double-clicking the connection, the saved password will

be used to connect the database.

The JDBC version must be corresponded with the database server’s version. For example if the server is

8.3.1 and the 8.3.1.XXXX JDBC version must be choose.

Clicking the [Browse], a dialog will be popped to manage All JDBC drivers.

1‘9 JDEC Management

JDBC Management
Load JDBC driver

JDBC Driver Wersion 1DBC Jar File

CUBRID-IDBC-8.3.1.0061 E:NCUBRIDYIDEC-8.3.1.0061-cubrid jar
CUBRID-IDEC-53.4.0.0103 E:\CUBRIDYIDEC-3.4.0.0103-cubrid. jar

@:‘ [ [0]4 H Cancel ]

Visit the web site http://www.cubrid.org/cubrid_java_programming to download the CUBRID JDBC

drivers.
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Open Connection

To open a dialog named “Open Connection” which is used to input connection information, please

right-click the connection node and selected the menu [Open Connection]:

11 Conmections = 7 O @) CUBRID Infc
Search: | w | dbaidi
=3 Default Group 1 SELECT *:
i0 Incalhost 2 )
=2y Rermote group i SELECT ™
g 10.34.63.122 S SELECT "

.ij -

M Open Connection...

L Mew Connection..,

L

14 Delete Connection

o Properties ALT+ENTER
o Hide
Z Refresh FS

And the dialog will be opened as follows:
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4 Dpen Connection

Open Connection
Please set the database connection infarmation and open connection,

Connection narme: |1EI.34.E|3.222 |

Database Information
Database IP: |1D.34.63.222

Database narme: |testdb

|
|
Lizer name: |dba |
|

Passwiord: |
Save password

Broker Information
Broker P |10,34.63.222 |

Eroker port: |45EIEIEI |

Character set: |UTF-B v|
IDEC versior: | CUBRID-IDEC-B.3.1.0061 v | |Erowse... |
@:l Connect ] ’ Caticel ]

If the [Save password] is checked, the password will be saved at local after [Connect] button pressed,
next, the operation of double click connection node will open the database connection directly without

open the dialog.

Delete Connection

Select a connection and select the [File]=>[Delete Connection] menu or [Delete Connection] menu in

the context menu of current selected connection to delete a connection.

Drag and Drop

Connections can be dragged and dropped to change their group or their display order.
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Table

When the database is connected, tables and system tables which current login user has been permitted to
visit will be listed under [Table] folder node in the navigation tree. The context menu of the [Table]

folder node in the navigation tree is as follows:

Connections =0

Search: v

=3 Default Group
= .,.D 10.34.63.132

- LE]

5.1 3 Create Table...

+ @ T Create Table Like...

i 5 Ewecute Prepared SOL 3
1|1l 5

-2y Remote 2 Hide
Z Refresh FS

Create Table

Right-click [Tables] in the navigation tree and then select [Create Table] or click [Create Table Lﬂ

button in the toolbar. Then, a wizard who makes you create a new table will be popped as follows:
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@ Create Table

Create Table

Please input a table name and add colurnns

General | Inheritance | FK/Indexes | Partition | S0OL Script

Tahle name: |newtable |
Dwner: |DEIA v |
Type: | |

Schema type: | |
[#]Reuse OID
[#]Show ohject oriented related properties

Colurnmes:
PK  Column Mame | Data Type Auto Increment | Default Mot Bull Unique
¢ INTEGER
| [name | VARCHAR - | [ |
< | L
(eot ] (e ) (oo
@j I Ok H Zancel ]

[General] tab: You can define the name of the new table and add, edit and drop columns of it. You
also can set the primary key (PK) and, before the table is created, change the order of the selected

column by using buttons [ t Jor [V ].

Using the [add] column wizard, you can set the name, type, default value and constraints of a new
column. You also can set to display a warning message when you enter something that is not

grammatically correct, or to disable the selection of a grammatically incorrect entry.

[Reuse OID]: If this option is selected, a table is created with the option [Reuse OID] applied.
For this kind of table, using with OID is restricted. For more information on OID reuse table, see Table

Options (Reuse OID).

[FK/Indexes] tab: You can set up foreign keys and indexes of the table.

[Add FK]: Using the [add foreign] key wizard, you can set the name of the foreign key, the name and
primary key of the reference table and the trigger actions to maintain referential integrity. The ON

UPDATE, ON DELETE and ON CACHE OBJECT options are provided.
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[Add Index]: You can set index name, index type, a column to be indexed. Ascending (asc) and
descending (desc) sorting can be selected within the supported range. For [REVERSE] indexes, only

descending sorting is supported.
[Partition] Tab: Supports partitioning setting and modification of the given table.

[Add] Partition: Using the add partition wizard, you can set the partition type and expression. The

RANGE, LIST and HASH partitions are supported.
[Edit] Partition: Edit partition.
[Delete] Partition: Delete partition.

[SQL Script] Tab: You can check and copy SQL statements created according to the settings in

[General]. [FK/Indexes] and [Partition] tabs.
[Adding Object Oriented Tables]

To add a table with object-oriented properties, select [Show object oriented related

properties]. When it is checked, the [Inheritance] tab is added to tabs.

@ Create Table

Create Table
@ Flease input a table name.

General FE/Indexes | Partition | 3QL Seript

Table name:

Owner : DE& ~
Type:

Sehema type:

Dﬁeuse 0ID
Show ohject oriented related properties:

Columns:
Auteo Imcrement Default Hot Hall Unique Shared Inheritance Cla=s
< >
e
@ L [ cenca |

[General] tab: When you select [Show object oriented related properties], Shared, Inheritance and

Table column are added as a column in the table. When adding or editing columns, you can choose the
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column type as shown in the figure below. You can choose OBJECT or a table in the database as the

data type.

‘% Add Column Eb—(

Add Column
) Flease choose a data type.

Cobumn name: id

Cooburmnn bype
(=) Instance (@la"T [ shared

Fiedd dimension

Duata bype: Liser imput b
TIMESTAMP ~
DATETIME
Def audt: value: BIT
BIT WVARYING
Constaink MONETARY
[unique

[Inheritance] tab: You can define the super table to inherit from. If a column name conflict

occurs, it can be adjusted.
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@ Create Table

Create Table
@ Please input a table name.

General | FK/Indexes | Partition | SOL Script
Super table list Super table information

testl PK | Column Mame  Data Type suto Increm.., | De

f2 MNCHAR[L)
< >
Add... ] [ Delete

Resolution Same colurmn names

Type Super table Columns Alias Type | Column Mame Data Type Table Mame
@j QK ] [ Cancel

Copy SQL

Users can generate SELECT/INSERT/UPDATE/DELETE/CREATE/GRANT SQLs about current

selected table(s) and copy them to current query editor, clipboard or a specific file. The menus as

follows:

== H —
é] 5 {r Mew Query Editor
[ Select Count(™)

Copy SOL to Editor

Copy SOL to Clipboard

L )
=k Copy SOL to File. ..
I ft [ Insert Simple Data...
SN Exerute Prepared S0L
=E
1 vigw gy Import Data...
& Trigd ¢/ Export Data,..
= Setia

i Store Shiowy Scherna Info...
10.34.61 -3 Edit Table...
Mare

o Hide

Z Refresh

SELECT <field_1=... «<field_n= FROM <table=

SELECT <field_1=...<field_n= FROM <table: WHERE ...

IMSERT INTO <table= ...
DELETE FROM <table= WHERE ...
LUPDATE <table= SET ...

CREATE =table= ...
GRANT
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Select All

Right-click a table in the navigation tree and select [More] = [Select all]. Or you can drag and drop the
table into the editor results panel of the Query editor when it is open. Then, a new Query editor opens

and retrieves the entire data.

Select Count

Retrieves total row count of the table and performs the same functionality as the following syntax.

SELECT COUNT (*) FROM [table-name]

4 Select count(*)

jr) abc: 17 records,

Delete All Records
[More]>[Delete All] menu will delete all records from the table and it is as same as the following SQL

statement:

DELETE FROM [table-name]

Truncate Table

[More]=>[Truncate Table] will delete all data of the table. It can delete all records including indexes
and constraints in a table, so it is faster than [DELETE ALL]. The ON DELETE trigger is not

activated when you use the [TRUNCATE TABLE]. It is as same as the following syntax.

TRUNCATE TABLE [table-name]

Insert Simple Data

You can insert values for each column while checking its type and constraints.
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#% Insert records to athlete

Insert Records

Flaase input walues for colunns

Column Tomain Congiraints Yalue

cade THTEGER futs Ineraoment, 20002

nane VARCHAR (407 Wot ¥all zhen han

gender CHAR L) |

natlon_code CHaZ (3) EOR

event VARCHAR (300 TEST DATA

inzert inte “athlete” [Meode”, “name”, “zender”, “nation_code”, “event”) welwesz (20001, 7 daniel
"M, THORT, CTEST DATA I
inzert inte “athlete” ["ecods™, “nane”, “gender®, "nation_coda”, “event”) walues (20002, 7 zhen han',

W, CEOR, CTEST DATA )
FE records connited,

Total 2 records inserted

“omm £ [ Cloax I [ Closa

€)

When you add more than one instance, you can separate them by adding a line break character between
each query and its result.

You can move the cursor to the next field by pressing the [Enter] key when you entered a value for
previous field.

When the [Clear] button is clicked, the value in the input box and the execution history will be
initialized.

The execution history panel cannot be edited.

For DATE, TIME, TIMESTAMP and DATETIME data types, you can enter different data for
each type. For example, for a DATE type, you can enter data such as SYSDATE, SYS_DATE,

CURRENT_DATE and DATE'2009-07-05".

Import Data
[Import data] can import data from an Excel or a CSV file into current selected table of the database.
Use [File charset] to specify the charset when getting data from a file, and use [JDBC charset] to

specify charset of the data to be imported into the database.

The [JDBC charset] only can be changed at the [Open Connection] dialog, and the new value will

work after the database is reconnected.
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4 Import Data

Import Data

Flease select the import file, data columns and imported
table columns,

Tagettooe: |

IDEC charset:  |UTF-g |
File marme: | | [Ern:uwze... ]
File charset: |GEIK i, |
Total lines: | |
Thread count: |5 =
Cormmit lines once: |5EIIIIIII =

Mapping between fle colums and table colurmns
[ luUse the first line data as column names
File: Colurmin Table calurmn

f1
f2
fa

Delete Up Down Delete

Errar-Handling: & Ignore and set error values to NULL O Break

@:J Irnport H Cancel

The import process support multi-thread to make better performance. The [Thread count] is used to
specify how many thread will run during the importing, 5 is recommended and don’t make it larger than

10.

[Commit lines once] is used to specify how many rows that memory cache stored in one thread, if the
memory cache is full, all data in the cache will be committed to the database and new data will start to

fill the memory cache.

If the first row of the import data is columns’ names, the [Use the first line data as column names]

should be checked.

The buttons [Delete](of file column), [Up], [Down], [Delete](of Table column) are used to specify the

correspondence between file columns and table columns.
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[Error-Handling] is used to specify what the import progress will do when errors occurred. If [Ignore]
is checked, the import progress will ignore all errors and show an error report dialog when progress is
finished and errors occurred. And if the [Break] is checked, the progress will be broke when error

occurred, but the committed data will not be rollback.

Export Data
Data (one or more tables) can be exported in Excel (.xIs), CSV, SQL, or CUBRID load (.obs) format.
The export progress will create a new file for each table and save the files into the path which users

specified in [File path]. [File charset] is used to specify the file charset of the exported data.

@ Export Data

Export Data

Export the data from selected columns of table or view,
Lsing the table name as exported file name,

Celect the colurmns of table or view to be exported

=] b |
[ fon2
1 = fon3
[ = info_thl
[] = zipcode
] ] viewl

[ ]5elect al

File path:

File type: Cornma separated value!™® . cev) “

File charset: |LUTF-2 w

[ |Use colurmns names as the first line data

3
'h? ') Cloze

Drop Table

Drop the selected table. This is the same as the DROP TABLE statement.

Rename Table
[More]>[Rename table] is used to change the name of the current table. It is the same as RENAME

TABLE statement.
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% Rename Table "abc”

Rename Table

Input a nesy name for the Table

Mew Table name: | |

Q

Create Table Like

Create an empty table that has a same schema with an existed one. It works as same as CREATE

TABLE LIKE statement. For more information, CREATE TABLE LIKE.

#% Create Like Table

Create Like Table
Create the same structure table like the selected iable,

Like table name: |code

Mew table name:

@ o [ Cancel ]

Edit Table

[Edit Table] is used to change the table’s owner, columns, inheritance, indexes, partition and etc. But the

table’s name and columns’ order can’t be changed.
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4 Edit Table "abc®
Edit Table "abc"
Edit the selected table

QEﬂEfa| Inheritance | FK{Indexes | Partition | SOL Script

Table name: | |

Owner: |DBA w |

Type: | |

Schema type: | |
ReLsze 010
[¥] Shiow object oriented related properties

Colurmns:
Pk Colurnn Mame | Data Type Auto Increm... | Default Mot Mull Linigue
P a INTEGER v %]
u] INTEGER
C IMTEGER
< | >

][+ Add... Edit... Delete

@ QK l [ Cancel

Show Schema Information

Double-click the table node or select the [Show Schema Info] menu to view the schema information of

the current selected table.
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_ athlete © .
athlete
Schema type User schema
Oryar PUBLIC
Saper Labile
Type Tabis
£ ¥
i olurre:
P Column Name Diaks Tyne Ao Incredneant Def sl Nk Mull Uinigis Shaed
[ code INTEGER ~r vl .
T VARCHAR{40) ]
Qi CHARI(L)
nation_code CHAR(T)
avank VAR CHAR[ 30
£ ¥
Foregn keys:
Fi. Nz Codurnn Mams Foreign Tabla Foresgn Cioksmn Mames Upsdate Ry Dealete Fuks Cz
£ ¥
Indeaas
I Bame Index Type (O Columns) Trude Flules
L ¥
Execute Prepared SQL

With [Execute Prepared SQL] menu, you can execute "prepared statement," pre-saving a specific

query statement and specifying a new parameter value for the statement whenever the query is executed.

._a, Insert Simple Data. ..

Execute Frepared ZAL

Eig Import Data. ..
£ Export Data. ..

™ m 1A

Select by input walue. .
Inzert by input walue. .

Select by read file. .
Inszert by read file. ..

You can execute the SELECT statement which meets specified conditions by entering a parameter

value of defined "prepared statement” by using [Select by input value].
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S Execute Defined SQL

Execute Defined SOL

Set prepared staternent parameters and value and execute
the self-defined SOL.

Self-defined SOL
SELECT "a", "h", "c" FROM "abc" WHERE a=? AMD b=7 AMD C=7;

Pararneters Setting

Pararneter MamefTndex Parameter Type Pararneter 4alue
a INTEGER,

b [MTEGER
C

BIGIMT
MUMERIC
FLOAT
DOLBLE
CHAR
WARCHAR
3 MCHAR b
MCHAR WARYIMNG

TIME Clear value
TIME

TIMESTAMP
DATETIME

BIT
@:‘ BIT WARYING

MOMNET ARY

STRIMNG

BLOE

CLOB

SET v

You can execute the INSERT statement by entering a parameter value of defined "prepared statement"

by using [Insert by input value].
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9 Execute Defined SOL

Execute Defined SOL
the self-defined SOL.

Self-defined SCL

Set prepared staternent parameters and value and execute

IMSERT INTO "zipcode" ("code”, "addrl”, "addr2", "addr3",
"addr4”, "addr5", "addrg") WALUES (7, 7, , 2, %, 7, PN

Pararneters Setting

Pararneter Marme/Inde:x

Pararmeter Type

code INTEGER

addrl IMNTEGER.

addr2 WARCHAR (40968

addr3 WARCHAR (40968

addr4 IMTEGER.

adch5  JINTEGER [ |
addria IMTEGER.

Patarmeter Walue

@

Clear value

Close

You can use [Select by read file] when repeating the execution of SELECT statement by inputting

several parameter values in the defined "prepared statement.” The data is saved in Excel (.xIs) or CSV

format. You can configure a file charset where parameter values are saved, the number of concurrent

threads to be executed, and commit cycle.
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19 Ezecute Defined SOL

Execute Defined SOL

Set mapping between prepared statement parameters and data from the
selected file and execute the self-defined SOL.

Self-defined SOL
CELECT "f1", “f2", "f3" FROM "foo2" WHERE f1=7 AND f2=7 AND f3=7,

Select File

File narme:
File: charset: GEK, | Total lirmes:

Thread count: |5 % | Commit lines once: (5000 —

JDBC Charset
JDBC charset: |UTF-8

Mapping for Parameters and Calurmin
Mapping between parameters and file colurns
[JUse the first line data as colurnn names

Paramneter Mame/Tndex Parameter Type File Calurnn
ifl BIGIMT
fz BIGIMT
fa BIGIMT

Clear colurmn

Errar-Handling: & Ignore and set error values to NULL O Break

3
'k?,' Cloze

You can use [Insert by read file] when repeating the execution of INSERT statement by inputting
several values in the defined "prepared statement." The data is saved in Excel (.xIs) or CSV format. You
can configure a file charset where parameter values are saved, the number of concurrent threads to be
executed, and commit cycle. [JDBC charset] can be changed in [Open connection] dialog, and it works

when the database is reconnected.
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'@ Execute Defined SOL

Execute Defined SOL

Set mapping between prepared staternent parameters and data from
the selected file and execute the self-defined SOL.

Self-defined SOL
IMSERT INTO "fooz2" ("f1", "f2", "f3") WwALUES (7, 7, ?;

Select File

Eile narne:
File: charset: Bk, w | Total lines:

Thread count: |5 % | Commit lines once: 5000 —

IDBC Charset
IOBC charset: |UTF-8

Mapping for Parameters and Caolumn
Mapping between parameters and file colurnns
[[Juse the first line data as column names

Parameter MamefIndex Pararmeter Type File Calurnn
ifl BIGIMT

fz BIGIMT

fa BIGINT

Clear colurnn

Error-Handling: & Ignore and set error values to WULL O Break

P
'h? ') Close
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View
When the database is connected, views and system views that are authorized to current login user will be
listed in the navigation tree.

= | Wiews
+-|_J Syskem views

Create View

Right-click [Views] in the navigation tree and then select [Create View].

—Im 1 Create Yiew, .,
-+

- o Hide

+
e
=

s SE

tL 5t & Refresh FS

¥

Specify the view’s name and the owner and click the [Add] button, and then enter the query statement

for the view to be created. The SQL statement of create view will be generated in the [SQL Script] tab.
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) Create View

Create View

Create a new view

General | SOL Script

wiew name: | |

e | DBa W |

Query specification list Selected query specification in details

add...

Colurnns:

Marne | Data type  Default type | Default value

@

Select All

The context menu [Select All] of view node will open a new query editor and select all data of current
selected view. The view node also can be dragged and dropped into a query editor to generate a select

statement of the view.

Select Count

Retrieves a total row count of the table and it works as same as the following syntax.

SELECT COUNT (*) FROM [view]

Export Data

You can export all data of the view to an Excel, CSV, SQL or CUBRID load format. For more please

refer to the [Export data] of table.
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Drop View

Drop the selected view. This is same as the DROP VIEW statement.

Rename View

You can change the name of the current view. This is as same as the RENAME VIEW statement.

Edit View

You can use all functionalities of [Create View] in [Edit View] as well.

View Information

You can check the schema information of the view by double-clicking it.

teest _views

test_view

Sthema type Liser schema

Ovaryar DEa

Swuper Labile

Type o

Colufirs

P Column Name
code
L o
genided
nation_coda
ewvent

€

Wiews query specicabon:

Diaka Type Aubo Incresnent Defaul

INTEGER

VARCHAR(107I741,.
HAR(1)

CHAR(L)

VARCHAR(1073741..

Nk Mull Liniqus Shared

et sthistes code, catsthists “name” 52 varchar), athisbs gendes, cadtisthiste nation_cods 52 charl 1)), cschi sthists avant &
warchae ) From athlete sthists whess sthilste . cods =1 000

Trigger

When the database is connected, triggers that are authorized to current login user will be listed in the

navigation tree.
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Create Trigger

Right-click [Triggers] in the navigation tree and then select [Create Trigger].

48 Create Trigger

Create Trigger
Flease input the below trigger information.

Trigger |SoL Script

Trigger name: Options
Trigger Event Trigger Status Trigger Priority
Event Target @ acTIVE Priarity: 00.00
Target table: v OmecTrve
Target column: Trigger &ction
S Execution Time
DEFALLT AFTER, DEFERRED
(& BEFORE O AFTER O DEFERRED © © ©
Action Type
Event Type
SREECT O INVALIDATE TRAMSACTION
(& INSERT (O STATEMENT IMNSERT
OPRINT ) OTHER STATEMENT
(O URDATE (OSTATEMENT UPDATE
()DELETE (JSTATEMEMT DELETE S0L statements ar print messages for action type
O commIT (OROLLBACK

Event Condition

Y
'\? ) Cancel

> Trigger name: Enter the name of the trigger to be added.

» Event Time: Select the point of time when the condition of the trigger is to be evaluated. You

can select from BEFORE, AFTER and DEFERRED.

>  Event Type: Select the type of the event to be occurred. Event types are INSERT, DELETE,
UPDATE, STATEMENT INSERT, STATEMENT DELETE, STATEMENT UPDATE,
COMMIT and ROLLBACK.

» Target table/Column: Enter the target table and column information.
» Event Condition: Enter the condition for the trigger action.

> Execution Time: Specify the point of time when the trigger is to be executed. If default is

selected, the trigger fires based on the point of time when its condition is validated.

>  Action Type: Select the type of the trigger action. If the type of the trigger action is PRINT,
OTHER or STATEMENT, you can enter additional information in the [SQL statements or print

messages] below.
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> Trigger Status: You can specify whether to activate or deactivate the trigger to be added.
> Trigger Priority: You can set the priority of the trigger. The priority value is a FLOAT and

can be between 00.00 and 9999.99.

Drop Trigger

Right-click the trigger in the navigation tree and then select [Drop Trigger].

Edit Trigger

Right-click the trigger in the navigation tree and then select [Edit Trigger]. You can simply edit a value

in the [Priority] field.

Serial

When the database is connected, serials that are authorized to current login user will be listed in the

navigation tree.

Create Serial

Right-click [Serials] in the navigation tree and then select [Create Serial].

The name of the serial must be unique in the database.
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“% Create Serial

Create Serial
Create a serial
| General | SQU Script
Serial name:
Skark waloe: o
Increment valee: | 1
10 walue: 0
May walue; 1 0000000000 00000000000 0MICC0A0000MmI0
[ Cyele
Drop Serial

Right-click the serial in the navigation tree and then select [Drop Serial].

Edit Serial

Right-click the serial in the navigation tree and then select [Edit Serial].

Stored Procedure

When the database is connected, procedures that are authorized to current login user will be listed in the

navigation tree.
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SR Stored procedure
L Function
[ Procedure

Create Function

It is a feature that registers a function written in Java in the database server with the loadjava

command and adds a database function in order to use the given Java function.

Right-click [Stored procedure] in the navigation tree and then select [Create Function].

“¥ Create Function

Eunction Setting | 5L Script

Function name: kest_func

Paramname | Param type  Java param type Model

id char javalang.String  IN
name char jawa.lang.Skring  IM
aod.. [ Edt.. || pele J[ 0t | 1 |
Reburn S0QL bype: WARCHAR w

Java Function name: = FindPerson Find

java,sgl.Date

java, sagl. Time

java, saql. Timestamp
java.lang Byte
java.lang, Short

Return JaVa Eype:

~
—

O ” Cancel J

Only Java types compatible with the selected SQL type are displayed so that the users can’t make a

mistake with type mapping.
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Create Procedure

It is a feature that registers a procedure written in Java in the database server with the loadjava

command and creates a database procedure in order to use the given Java procedure.

Right-click [Stored procedure] in the navigation tree and then select [Create Procedure].

*% Create Procedure

Procedure Setting | SQL Script

Procedurs name: kest_proc

Paramname  Param type  Java param type  Model

a CHAR, jawa.lang.Skring  IN
b CHAR java.lang.String IM

[ add. || Ede.. || opeleee || t [ 1 ]

Java funckion name:  FindPerson. FindProc

) oL ” Cancel J

Only Java types compatible with the selected SQL type are displayed so that the user does not make a

mistake with type mapping.

The following is a statement created by using the Create Procedure wizard above.
CREATE PROCEDURE "test_proc"("a" CHAR,"b" CHAR)

AS LANGUAGE JAVA

NAME 'FindPerson.FindProc(java.lang.String,java.lang.Integer)'
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Drop Function/Procedure

Right-click a certain function or a procedure and then select [Drop Function] or [Drop Procedure].

Edit Function/Procedure

Right-click a certain function or a procedure and then select [Edit Function] or [Edit Procedure]. The

feature works the same as with Create Function/Procedure.

Preference

[File]>[Preference] menu is used to open the preference dialog:

#EN Edit Tools Action  Help

[ L Mew Connectian...

Close ey
Close Al Ctrl+Shift+w

Preferences...

Z Refresh FS

Exit

Users can change some preference options by using the dialog.

General

This page is used to set up some general options.
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48 preferences

General f=1n -
General
Query Options [ st window raxirnize
Irnport Options [ ahways exit without prompt
IDBC Management [“] Check the new information of CUBRID
= Help
Open mode
Cantent ) )
O single click
%) Double dlick
@j [ OK ] [ Cancel l

«  Show window maximize: If it is checked, the query browser will be maximized when it started.
»  Always exit without prompt: if it is checked, there is no prompt when query browser is closing.

*  Check the new information of CUBRID: if it is checked, an new information of CUBRID editor

will be opened when the query browser started.

*  Open mode: use single click or double dick to open nodes in the connection explorer.

Query Options

This page is used to set some options about query editor.
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4 Preferences
Query Options (Sl -
Gereral
8 Dptions
Import Options [ Autocormmit
JDBC Management
+-Help
Search unit of result instances 5000 —
Page unit of result instances 100 =
[“]Enatle query plan
[]Get OID info{updateable result)
[(IMake keywords and functions lowercase
[l without prompt ta save on close when non-file editar is dirty
Change Font
Font Example
CLBRID
[ghange... ] ’Eestore defauilt
Change Style
) split vertically(SOL editor and result panel)
O Parallel horizontally(SQL editor and result panel)
Mote: This style is in effect only when reopen the query editor,
3
2 [ OK l ’ Cancel ]

« Autocommit: You can set a default value so that autocommit is performed after a query is executed
in the query edit pane. Even when [Autocommit] is selected, you can set ([ ‘3{ i)/clear ( S}) the

function from the toolbar in the Query Editor.

» Search unit of result instances: Sets the number of result rows to be fetched at once from the
database after the execution of the query. That is, if the number of search result rows is 7,000 when
the value is set to 5,000, you can select whether or not to continue to fetch more search results after
5,000 rows are fetched. In addition, if you execute queries that satisfy the following conditions,
ROWNUM is automatically added based on the set value to prevent using excessive server

resources.
WHERE condition is missing.
GROUP BY is not used.
ORDER BY is not used.

Aggregate functions (SUM, COUNT, MIN, MAX, AVG, STDDEV and VARIANCE) are not
used.
« Hierarchical Query is not used.

«  Page unit of result instances: You can navigate in the query results pane by paging ([<= 4 <& =)
specified number of records.

* Enable query plan : You can check the query plan before and after its execution. Selecting this
option may slightly affect the query execution time because plan information will be created in

advance for queries to be executed.
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* Get OID info: Fetches OID information during the query execution. This allows you to directly
modify/delete data in the query results pane. However, “NONE” is displayed if the OID cannot be
fetched as with Join queries. Selecting this option may extend the query execution time.

* Make keywords and functions lowercase: The auto-complete will show the keywords as

lowercase.

*  Without prompt to save on close when non-file editor is dirty: If the editor doesn’t open a file,

the save prompt will not pop on close whether the editor is dirty or not.
+ Change font & size: You can change fonts and their sizes to be used in the Query Editor.

* Change Style: Change the show style of query editor’s editor panel and result panel.

Import Options

Import options is used to specify which value will be turn to NULL when import data to database.

Strings ‘NULL’, {(NULL)’ and \N” are the default options and users can input some custom values into

the text area, the max length of text is 256.

9 Preferences

Import Options (=l -
General
Query Options The selected strings below will be regarded as MULL walue during importing or updating.
Import Options
IDBC Management MULL! (MULLY L
Help Other Yalues (Split by ') null, (ool
’Restore Defaults ] ’ Anply ]
':?:' [ K l [ Cancel ]
JDBC Management

Users can manage various CUBRID JDBC drivers by this page.
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4§ Preferences

| JDBC Management LT b
General
Query Options JDEC Driver Wersion IDBC Jar File
Impart Cptians CUBRID-IDBC-8.3.1.0061 E:\CUBRIDYIDBC-8.3.1.0061-Cu..,
1DBC Managernent CUBRID-1DBC-8,4.0.0103 E:\CUBRIDYJDBC-8.4.0.0103-Cu..,
Help
C':?j [ OK. ] ’ Cancel ]

Button [Add] will open a file selection dialog, and the specified CUBRID JDBC driver file will be

added to the JDBC driver list.

Button [Delete] will delete current selected JDBC driver from the list.

Help

Set up preference options of CUBRID Query browser help:
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Preferences
| | | Help 4= o v
gir;.rg;atljptions Specify hD\: help information is displayed.
Import Cptions Open Mades
1DBC Mahagement Open help s=arch
Help |In the dynarmic help view v|
Open help contents
|In the help browser V|
ContextHelp
Open window context help
|In the dynamic help view V|
Open dislog context help
|In a dlizlog tray v |
’Restore Qefaults] ’ Apply ]
@ [ OK ] [ Cancel ]

Set up the remove help content:

2 Preferences

| | | content 4 o v

General
Query Options
Import Options

IDEC Management Marme URL Enabled
=-Help

[indude help content: from a remate infocenter
Rermote Infocenters:

Content

’Restore Qefaults” Apply ]

@ [ Ok H Cancel ]
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